
Аппроксимация функций с использованием 

нейронных сетей 
 

Аппроксимация функций является одним из самых общих 
использований искусственных нейронных сетей. Нейронные сети — могут 
аппроксимировать непрерывные функции. Научно доказана «Обобщенная 
аппроксимационная теорема и вычислительные возможности нейронных 
сетей», согласно которой с помощью линейных операций и каскадного 
соединения можно из произвольного нелинейного элемента получить 
устройство, вычисляющее любую непрерывную функцию с некоторой 
наперёд заданной точностью. Это означает, что нелинейная характеристика 
нейрона может быть произвольной. От выбора нелинейной функции может 
зависеть сложность конкретной сети, но с любой нелинейностью сеть остаётся 
универсальным аппроксиматором и при правильном выборе структуры 
может достаточно точно аппроксимировать функционирование любого 
непрерывного автомата. 

Определим общую задачу аппроксимации как задачу построения 
непрерывной зависимости с заданными свойствами по дискретному набору 
данных. Формально задача сводится к поиску категорийного отображения 

, определяющего для каждого дискретного набора данных вектор 
в координатном пространстве  размерностью n, равной числу узлов-точек 
входного набора данных  , точку-вектор в m-мерном пространстве 

параметров модели .  Данное отображение должно удовлетворять 
обобщенному критерию качества аппроксимации , который, в 
целом, вмещает в себя как требуемую точность аппроксимации  или 
минимизацию ошибки, так и  дополнительные требования к внешнему виду 
или поведению модели за пределами области данных.  

Рассмотрим применение нейронных сетей для аппроксимации функций 
на следующем примере: 

Создадим, используя нейронную сеть, аппроксимирующую функцию 
F(x,y,знак,z), позволяющую выполнять расчеты по следующим формулам: 
F(x,y,”+”,z)=x+y+z и F(x,y,”*”,z)=x+y*z. 

 

 



Применение пакета «STATISTICA Neural Networks» для 
Аппроксимации функций с использованием нейронных сетей 

 

Решение данной задачи продемонстрируем с использованием пакета 
для всестороннего статистического анализа и нейросетевых исследований 
«STATISTICA Neural Networks»1. 

 Для создания обучающей выборки разработаем программу на языке 
Visual Basic for Application для MS Excel 
 

Private Sub CommandButton1_Click() 

st = 2 'Номер строки для вывода 

For x = 0 To 10 ' обучающая выборка от для х=0 до 10 

For y = 0 To 10 

For z = 0 To 10 

' Формируем строку для первой фунции 

Cells(st, 1) = x   ' 1 столбец выборки 

Cells(st, 2) = y   ' 2 столбец выборки 

Cells(st, 3) = "+" 

Cells(st, 4) = z 

Cells(st, 5) = x + y + z 

st = st + 1 

' Формируем строку для второй фунции 

Cells(st, 1) = x   ' 1 столбец выборки 

Cells(st, 2) = y   ' 2 столбец выборки 

Cells(st, 3) = "*" 

Cells(st, 4) = z 

Cells(st, 5) = x + y * z 

st = st + 1 

                                                             
1 Запуск осуществляется в системе виртуализации VirtualBox. 



Next z 

Next y 

Next x 

End Sub 

 Создадим обработчик события «ButtonClick»  элемента «Button1»-
«Создание выборки» (Рис. Ошибка! Текст указанного стиля в документе 
отсутствует..1), содержащий выше описанную программу на Visual Basic for 
Application для MS Excel.  
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..1. 
Рабочий лист MS Excel для создания обучающей выборки 

 

 Нажав на созданную кнопку «Создание выборки» (Рис. Ошибка! Текст 
указанного стиля в документе отсутствует..1) получаем обучающую выборку, 
стоящую из 2662 строк данных. 

 В «STATISTICA Neural Networks» создадим область данных для 
обучающей выборки, выполнив последовательность действий File->New-
>Data Set. 

 Поскольку, согласно условию, имеется четыре входных параметра 
(x,y,«знак»,z) и один выходной параметр F(x,y,«знак»,z), то заполним форму 
«Create Data Set» как изображено на Рис. Ошибка! Текст указанного стиля в 
документе отсутствует..2. 
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..2. Форма 
ввода параметров области данных для выборки 



 

 Дополним, открывшуюся после нажатия на кнопку «Create», форму 
«Data Set Edition (new)» пустыми строками для заполнения данными 
обучающей выборки, выполнив последовательность действий Edit-> Cases-> 
Add и заполним форму «Add Cases» как изображено на Рис. Ошибка! Текст 
указанного стиля в документе отсутствует..3 , поскольку в исходной выборке 
имеется 2662 строки данных.  
 

 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..3. Форма 
ввода количества добавляемых строк области данных 

 

 

 Назначим для столбца «VAR3», являющегося входным параметром 
(знак) обучающей выборки, возможные значения «+» и «*». Для этого 
выделим данный столбец, выбрав пункт контекстного меню Definition  
(Рис. Ошибка! Текст указанного стиля в документе отсутствует..4) и заполним 
форму «Variable Definition» для двух возможных значений входного 
параметра «VAR3». 
 

 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..4. 
Назначение возможных значений выходного параметра «VAR3» 

 

 Выполним копирование 2662 строк обучающей выборки, 
сгенерированных нами ранее в MS Excel,  в форму «Data Set Edition (new)» (Рис. 
Ошибка! Текст указанного стиля в документе отсутствует..5). 
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..5. 
Исходная выборка данных 

 



 Пометим 10% строк обучающей выборки как «проверочные» (пункт 
Verification контекстного меню). Для этого уменьшим на ~10% количество 

«обучающих» строк выборки .   
 Перераспределим «проверочные» и «обучающие» строки обучающей 

выборки, выполним последовательность действий Edit->Cases->Shuffle->Train 
and Verify. 

 Создадим нейронную сеть, выполнив последовательность действий 
File->New->Network. 

 Заполним форму «Create Network» в соответствии с Рис. Ошибка! Текст 
указанного стиля в документе отсутствует..6 и создадим сеть (Рис. Ошибка! 
Текст указанного стиля в документе отсутствует..7) нажав кнопку «Create». 
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..6. 
Создание нейронной сети 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..7. 
Графическое представление созданной нейронной сети 

 

 Обучаем полученную нейронную сеть, используя различные варианты 
обучения, представленные пунктом меню Train->Multilayer Perceptrons. 

 Для проверки уровня обучения сети удобно использовать  форму 
«Training Error Graph» (Рис. Ошибка! Текст указанного стиля в документе 
отсутствует..8), вызываемую Statistics -> Training Graph. 
Особое внимание на этой форме следует обратить на количественные 
значения ошибки проверки и обучения нейронной сети.  

 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..8. Форма 
проверки уровня обучения сети 

 



 После успешного обучения нейронной сети (ошибка проверки и  
ошибка обучения нейронной сети стремятся к 0) для вычисления с помощью 
созданной нами аппроксимирующей функции необходимо добавить две 
дополнительные строки данных, выполнив последовательность действий 
Edit->Cases->Add, пометить их как игнорируемые (пункт Ignore контекстного 
меню) и заполнить их контрольными примерами (Рис. Ошибка! Текст 
указанного стиля в документе отсутствует..9). 
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..9. 
Заполнение контрольных примеров  

 

 Выполнив последовательность действий Run->Single Case для 1-2 
строки данных (Рис. Ошибка! Текст указанного стиля в документе 
отсутствует..10 Рис. Ошибка! Текст указанного стиля в документе 
отсутствует..11), получаем, что созданная нами нейронная сеть успешно 
аппроксимирует обе выбранные нами функции, погрешность вычислений при 
этом довольно не значительна и составляет в среднем 0,03-0,04%. 
 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..10. 
Выполнение проверки аппроксимации нейронной сетью функции 

F(x,y,”+”,z)=x+y+z 

 
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..11. 
Выполнение проверки аппроксимации нейронной сетью функции 

F(x,y,”*”,z)=x+y*z 
 

 

  



Классификационный анализ с использованием 

нейронных сетей 
 

Решение задачи классификации является одним из важнейших 
применений нейронных сетей. Задача классификации представляет собой 
задачу отнесения образца к одному из нескольких попарно не 
пересекающихся множеств. Примером таких задач может быть, например, 
задача определения кредитоспособности клиента банка, медицинские 
задачи, в которых необходимо определить, например, исход заболевания, 
решение задач управления портфелем ценных бумаг (продать купить или 
"придержать" акции в зависимости от ситуации на рынке), задача 
определения жизнеспособных и склонных к банкротству фирм. 

Нейронные сети являются наиболее эффективным способом 
классификации, потому что генерируют фактически большое число 
регрессионных моделей (которые используются в решении задач 
классификации статистическими методами). 

Однако, в применении нейронных сетей в практических задачах 
возникает ряд проблем. Во-первых, заранее неизвестно какой сложности 
(размера) может потребоваться сеть для достаточно точной реализации 
отображения. Эта сложность может оказаться чрезмерно высокой, что 
потребует сложной архитектуры сетей.  

При решении задач классификации необходимо отнести имеющиеся 
статические образцы (характеристики ситуации на рынке, данные 
медосмотра, информация о клиенте) к определенным классам. Возможно 
несколько способов представления данных. Наиболее распространенным 
является способ, при котором образец представляется вектором. Компоненты 
этого вектора представляют собой различные характеристики образца, 
которые влияют на принятие решения о том, к какому классу можно отнести 
данный образец. Например, для медицинских задач в качестве компонентов 
этого вектора могут быть данные из медицинской карты больного. Таким 
образом, на основании некоторой информации об образце, необходимо 
определить, к какому классу его можно отнести. Классификатор таким 
образом относит объект к одному из классов в соответствии с определенным 
разбиением N-мерного пространства, которое называется пространством 
входов, и размерность этого пространства является количеством компонент 
вектора. 



Для построения классификатора необходимо определить, какие 
параметры влияют на принятие решения о том, к какому классу принадлежит 
образец. При этом могут возникнуть две проблемы. Во-первых, если 
количество параметров мало, то может возникнуть ситуация, при которой 
один и тот же набор исходных данных соответствует образцом, находящимся 
в разных классах. Тогда невозможно обучить нейронную сеть, и система не 
будет корректно работать (невозможно найти минимум, который 
соответствует такому набору исходных данных). Исходные данные 
обязательно должны быть непротиворечивы. Для решения этой проблемы 
необходимо увеличить размерность пространства признаков (количество 
компонент входного вектора, соответствующего образцу). Но при увеличении 
размерности пространства признаков может возникнуть ситуация, когда 
число образцов может стать недостаточным для обучения сети, и она вместо 
обобщения просто запомнит примеры из обучающей выборки и не сможет 
корректно функционировать. Таким образом, при определении признаков 
необходимо найти компромисс с их количеством. 

Далее необходимо определить способ представления входных данных 
для нейронной сети, то есть определить способ нормирования. Нормировка 
необходима, поскольку нейронные сети работают с данными, 
представленными числами в диапазоне 0..1, а исходные данные могут иметь 
произвольный диапазон или вообще быть нечисловыми данными. При этом 
возможны различные способы, начиная от простого линейного 
преобразования в требуемый диапазон и заканчивая многомерным анализом 
параметров и нелинейной нормировкой в зависимости от влияния 
параметров друг на друга. 

Задача классификации при наличии двух классов может быть решена на 
сети с одним нейроном в выходном слое, который может принимать одно из 
двух значений 0 или 1, в зависимости от того, к какому классу принадлежит 
образец. При наличии нескольких классов возникает проблема, связанная с 
представлением этих данных для выхода сети. Наиболее простым способом 
представления выходных данных в таком случае является вектор, компоненты 
которого соответствуют различным номерам классов. При этом i-я 
компонента вектора соответствует i-му классу. Все остальные компоненты при 
этом устанавливаются в 0. Тогда, например, второму классу будет 
соответствовать 1 на 2 выходе сети и 0 на остальных. При интерпретации 
результата обычно считается, что номер класса определяется номером 
выхода сети, на котором появилось максимальное значение. Например, если 
в сети с тремя выходами мы имеем вектор выходных значений (0.2,0.6,0.4), то 



мы видим, что максимальное значение имеет вторая компонента вектора, 
значит класс, к которому относится этот пример, – 2. При таком способе 
кодирования иногда вводится также понятие уверенности сети в том, что 
пример относится к этому классу. Наиболее простой способ определения 
уверенности заключается в определении разности между максимальным 
значением выхода и значением другого выхода, которое является 
ближайшим к максимальному. Например, для рассмотренного выше примера 
уверенность сети в том, что пример относится ко второму классу, определится 
как разность между второй и третьей компонентой вектора и равна 0.6-
0.4=0.2. Соответственно чем выше уверенность, тем больше вероятность того, 
что сеть дала правильный ответ. Этот метод кодирования является самым 
простым, но не всегда самым оптимальным способом представления данных. 

Следующим важным моментом при решении задач классификации 
является правильный выбор архитектуры нейронной сети. Построить 
небольшую и качественную нейронную сеть часто бывает просто невозможно, 
а большая нейронная сеть будет просто запоминать примеры из обучающей 
выборки и не производить аппроксимацию, что, естественно, приведет к 
некорректной работе классификатора. Существуют два основных подхода к 
построению нейронной сети – конструктивный и деструктивный. 

При первом из них вначале берется нейронная сеть минимального 
размера, и постепенно увеличивают ее до достижения требуемой точности. 
При этом на каждом шаге ее заново обучают. Также существует так 
называемый метод каскадной корреляции, при котором после окончания 
эпохи происходит корректировка архитектуры нейронной сети с целью 
минимизации ошибки. При деструктивном подходе вначале берется 
нейронная сеть завышенного объема, и затем из нее удаляются узлы и связи, 
мало влияющие на решение. При этом полезно помнить следующее правило: 
число примеров в обучающем множестве должно быть больше числа 
настраиваемых весов. Иначе вместо обобщения нейронная сеть просто 
запомнит данные и утратит способность к классификации – результат будет не 
определен для образцов, которые не вошли в обучающую выборку. 

При выборе архитектуры сети обычно опробуется несколько 
конфигураций с различным количеством элементов. При этом основным 
показателем является объем обучающего множества и обобщающая 
способность нейронной сети.  

 



1.1.1 Применение пакета «STATISTICA Neural Networks» для 
классификационного анализа с использованием нейронных сетей 

 

Рассмотрим применение классификационного анализа с использованием 
нейронных сетей на примере прогнозирования рентабельности  
потребсоюзов.  

По результатам статистического анализа финансовых показателей 
потребсоюзов за 2009 года (использовано 2 показателя: объем продаж и 
прибыль) были выявлены две группы потребсоюзов: группа «А» – 
рентабельные, группа «В» – нерентабельные. 

Несколько потребсоюзов сделали прогноз своего развития на текущий 
год и представили его в форме (Таблица Ошибка! Текст указанного стиля в 
документе отсутствует..1). Необходимо определить, используя значения 
прошлого года в качестве обучающей выборки, какие из потребсоюзов 
окажутся рентабельными, а какие нерентабельными. 

Финансовые показатели потребсоюзов 

Таблица Ошибка! Текст указанного стиля в документе отсутствует..1 
Рентабельные Нерентабельные Прогноз 

объем 
продаж 

прибыль 
объем 

продаж 
прибыль 

объем 
продаж 

прибыль 

1,681819 0,030908 5,886363 0,665634 6,727273 0,623579 

1,85 0,034141 5,213637 0,680305 4,372727 0,554121 

1,513636 0,035622 5,55 0,697755 5,381818 0,768088 

1,345454 0,042527 6,895454 0,698502 3,7 0,137848 

2,186364 0,075902 5,045455 0,701284 5,213637 0,440325 

0 0,08062 8,409091 0,707762 6,390909 0,259315 

1,177273 0,097971 7,063636 0,718383  

3,868181 0,110858 1,009091 0,447815  

4,036364 0,113395 2,354545 0,460619  

0,168182 0,122655 1,177273 0,464182  

2,018182 0,123012 0,336363 0,50837  

0,672728 0,140816 0,504545 0,515573  



2,690909 0,248955 0,840909 0,518642  

2,522727 0,252809 3,868181 0,523756  

4,709091 0,267014 0,672728 0,525888  

3,363636 0,270132 3,7 0,535011  

6,727273 0,273323 4,204546 0,53748  

6,054545 0,282188 6,222728 0,564866  

2,859091 0,282605 6,559091 0,583061  

6,559091 0,291241 3,531818 0,585896  

5,886363 0,30606 2,522727 0,600383  

6,222728 0,311093 4,540909 0,606183  

3,027273 0,312837 6,390909 0,609316  

3,195455 0,315252 3,363636 0,60973  

6,895454 0,321926 2,690909 0,622973  

5,55 0,334944 4,877272 0,62401  

5,045455 0,34391 4,709091 0,624184  

4,877272 0,350406 2,859091 0,624865  

8,409091 0,362058 3,195455 0,63469  

5,381818 0,363705 5,718182 0,636022  

5,718182 0,370022 6,054545 0,648151  

7,063636 0,382344 1,681819 0,351117  

8,240909 0,413256 0 0,354079  

8,072727 0,426519 0,168182 0,383487  

7,231819 0,453037 1,85 0,386482  

7,904545 0,482276 2,018182 0,390141  

7,736364 0,484801 1,345454 0,398474  

7,4 0,50164 1,513636 0,401233  

7,568182 0,550972 2,186364 0,419636  

0,336363 0,145201 4,036364 0,445616  

2,354545 0,162325 3,027273 0,664423  

1,009091 0,165158 8,240909 0,742959  

0,504545 0,16808 8,072727 0,750651  



 

Продолжение Таблица Ошибка! Текст указанного стиля в документе 
отсутствует..1 

 

4,204546 0,191173 7,231819 0,767444  

0,840909 0,200926 7,4 0,777356  

4,540909 0,218025 7,904545 0,857802  

4,372727 0,220508 7,568182 0,868987  

3,531818 0,236922 7,736364 0,881827  

 

Решение данной задачи продемонстрируем с использованием пакета для 
всестороннего статистического анализа и нейросетевых исследований 
«STATISTICA Neural Networks»2. 

 Создадим область данных для обучающей выборки, выполнив 
последовательность действий File->New->Data Set. 

 Поскольку, согласно условию, имеется два входных параметра (объем 
продаж и прибыль) и один выходной параметр (рентабельность), то заполним 
форму «Create Data Set» как изображено на Рис. Ошибка! Текст указанного 
стиля в документе отсутствует..12.  
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..12. 
Форма ввода параметров области данных для выборки 

 

 Дополним открывшуюся после нажатия на кнопку «Create» форму 
«Data Set Edition (new)» пустыми строками для заполнения данными 
обучающей выборки, выполнив последовательность действий Edit-> Cases-> 
Add и заполним форму «Add Cases» как изображено на Рис. Ошибка! Текст 
указанного стиля в документе отсутствует..13, поскольку в исходной выборке 
имеется 102 строки данных (96 исходные и 6 экспериментальные).  
 

                                                             
2 Запуск осуществляется в системе виртуализации VirtualBox 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..13. 
Форма ввода количества добавляемых строк области данных  

 

 

 

 Преобразуем Таблица Ошибка! Текст указанного стиля в документе 
отсутствует..1. к виду, представленному в  
таблица Ошибка! Текст указанного стиля в документе отсутствует..2., 
предварительно заменив знак «,» на «.» в исходной Таблица Ошибка! Текст 
указанного стиля в документе отсутствует..1, поскольку в «STATISTICA Neural 
Networks» используется знак «.» в качестве разделителя. 

Преобразованная выборка данных 

таблица Ошибка! Текст указанного стиля в документе отсутствует..2.  
Объем 
продаж Прибыль Рентабельность 

1.681819 0.030908 рент. 

1.85 0.034141 рент. 

1.513636 0.035622 рент. 

1.345454 0.042527 рент. 

2.186364 0.075902 рент. 

0 0.08062 рент. 

1.177273 0.097971 рент. 

3.868181 0.110858 рент. 

4.036364 0.113395 рент. 

0.168182 0.122655 рент. 

2.018182 0.123012 рент. 

0.672728 0.140816 рент. 



2.690909 0.248955 рент. 

2.522727 0.252809 рент. 

4.709091 0.267014 рент. 

3.363636 0.270132 рент. 

6.727273 0.273323 рент. 

6.054545 0.282188 рент. 

2.859091 0.282605 рент. 

6.559091 0.291241 рент. 

5.886363 0.30606 рент. 

6.222728 0.311093 рент. 

3.027273 0.312837 рент. 

3.195455 0.315252 рент. 

6.895454 0.321926 рент. 

5.55 0.334944 рент. 

5.045455 0.34391 рент. 

4.877272 0.350406 рент. 

8.409091 0.362058 рент. 

5.381818 0.363705 рент. 

5.718182 0.370022 рент. 

7.063636 0.382344 рент. 

8.240909 0.413256 рент. 

8.072727 0.426519 рент. 

 

  



Продолжение таблица Ошибка! Текст указанного стиля в документе 
отсутствует..2. 

7.231819 0.453037 рент. 

7.904545 0.482276 рент. 

7.736364 0.484801 рент. 

7.4 0.50164 рент. 

7.568182 0.550972 рент. 

0.336363 0.145201 рент. 

2.354545 0.162325 рент. 

1.009091 0.165158 рент. 

0.504545 0.16808 рент. 

4.204546 0.191173 рент. 

0.840909 0.200926 рент. 

4.540909 0.218025 рент. 

4.372727 0.220508 рент. 

3.531818 0.236922 рент. 

5.886363 0.665634 не рент. 

5.213637 0.680305 не рент. 

5.55 0.697755 не рент. 

6.895454 0.698502 не рент. 

5.045455 0.701284 не рент. 

8.409091 0.707762 не рент. 

7.063636 0.718383 не рент. 

1.009091 0.447815 не рент. 

2.354545 0.460619 не рент. 

1.177273 0.464182 не рент. 

0.336363 0.50837 не рент. 



0.504545 0.515573 не рент. 

0.840909 0.518642 не рент. 

3.868181 0.523756 не рент. 

0.672728 0.525888 не рент. 

3.7 0.535011 не рент. 

4.204546 0.53748 не рент. 

6.222728 0.564866 не рент. 

6.559091 0.583061 не рент. 

3.531818 0.585896 не рент. 

2.522727 0.600383 не рент. 

4.540909 0.606183 не рент. 

6.390909 0.609316 не рент. 

3.363636 0.60973 не рент. 

2.690909 0.622973 не рент. 

4.877272 0.62401 не рент. 

4.709091 0.624184 не рент. 

2.859091 0.624865 не рент. 

3.195455 0.63469 не рент. 

5.718182 0.636022 не рент. 

6.054545 0.648151 не рент. 

1.681819 0.351117 не рент. 

0 0.354079 не рент. 

0.168182 0.383487 не рент. 

1.85 0.386482 не рент. 

2.018182 0.390141 не рент. 

1.345454 0.398474 не рент. 

1.513636 0.401233 не рент. 



2.186364 0.419636 не рент. 

4.036364 0.445616 не рент. 

3.027273 0.664423 не рент. 

8.240909 0.742959 не рент. 

8.072727 0.750651 не рент. 

7.231819 0.767444 не рент. 

7.4 0.777356 не рент. 

7.904545 0.857802 не рент. 

7.568182 0.868987 не рент. 

7.736364 0.881827 не рент. 

6.727273 0.623579   

4.372727 0.554121   

5.381818 0.768088   

3.7 0.137848   

5.213637 0.440325   

6.390909 0.259315   

 

 Назначим для столбца «VAR3», являющегося выходным параметром 
(рентабельность) обучающей выборки, возможные значения «рент.» и «не 
рент.». Для этого выделим данный столбец, выбрав пункт контекстного меню 
Definition (Рис. Ошибка! Текст указанного стиля в документе отсутствует..14) и 
заполним форму «Variable Definition» для двух возможных значений 
выходного параметра «VAR3» как изображено на Рис.  Ошибка! Текст 
указанного стиля в документе отсутствует..15 Рис. Ошибка! Текст указанного 
стиля в документе отсутствует..16. 
 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..14. 
Назначение возможных значений выходного параметра «VAR3» 

 

 

Рис.  Ошибка! Текст указанного стиля в документе отсутствует..15. 
Заполнение 1-го возможного значения параметра «VAR3» 

 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..16. 
Заполнение 2-го возможного значения параметра «VAR3» 



 
 Выполним копирование данных обучающей выборки таблица 

Ошибка! Текст указанного стиля в документе отсутствует..2. в форму «Data Set 
Edition (new)» (Рис. Ошибка! Текст указанного стиля в документе 
отсутствует..17). 
 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..17. 
Исходная выборка данных 

 

 Пометим строки обучающей выборки с 97-102 как игнорируемые 
(пункт Ignore контекстного меню) в процессе обучения нейронной сети (Рис. 
Ошибка! Текст указанного стиля в документе отсутствует..18), поскольку они 
будут использоваться для предсказания рентабельности после обучения 
нейронной сети. 
 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..18. 
Пометка строк исходной обучающей выборки с 97-102 как игнорируемых 

 

 Пометим 20% строк обучающей выборки как «проверочные» (пункт 
Verification контекстного меню). Для этого уменьшим на ~20% количество 

«обучающих» строк выборки .   
 Перераспределим «проверочные» и «обучающие» строки обучающей 

выборки, выполним последовательность действий Edit->Cases->Shuffle->Train 
and Verify. 

 Создадим нейронную сеть, выполнив последовательность действий 
File->New->Network. 

 Заполним форму «Create Network»  в соответствии с Рис. Ошибка! 
Текст указанного стиля в документе отсутствует..19   и создадим сеть (Рис. 
Ошибка! Текст указанного стиля в документе отсутствует..20) нажав кнопку 
«Create». 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..19. 
Создание нейронной сети 

 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..20. 
Графическое представление созданной нейронной сети 

 

 Обучаем полученную нейронную сеть, используя различные варианты 
обучения, представленные пунктом меню Train->Multilayer Perceptrons (Рис. 
Ошибка! Текст указанного стиля в документе отсутствует..21). 
 



 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..21. 
Обучение нейронной сети 

 

 Для проверки уровня обучения сети удобно использовать  форму 
«Training Error Graph» (Ошибка! Источник ссылки не найден.), вызываемую 
Statistics -> Training Graph. 
Особое внимание на этой форме следует обратить количественному 
значению ошибки проверки нейронной сети, которое не должны 
превосходить значения 0.001.  

 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..22. 
Форма проверки уровня обучения сети 

 

 После успешного обучения нейронной сети (ошибка проверки 
нейронной сети стремится к 0) для определения какие из потребсоюзов 
окажутся рентабельными, а какие нерентабельными воспользуемся формой 



«Run Single Case» для строк 97-102, содержащих данные прогноза развития 
потребсоюзов на текущий год, выполнив для этого последовательность 
действий Run->Single Case (Рис. Ошибка! Текст указанного стиля в документе 
отсутствует..23). 
 

 

 

Рис. Ошибка! Текст указанного стиля в документе отсутствует..23. 
Форма обработки данных обученной нейронной сетью 

 

 Используя значения «Output» выдаваемые нейронной сетью в 
качестве прогнозируемых для строк от 97-102 получаем, что первые 3 
потребсоюза окажутся не рентабельными, а 4-6 потребсоюзы будут 
рентабельными (Таблица Ошибка! Текст указанного стиля в документе 
отсутствует..3). 
 

 

Прогноз рентабельности потребсоюзов  

Таблица Ошибка! Текст указанного стиля в документе отсутствует..3 
№ 

потребсоюза 
Объем 
продаж 

Прибыль Рентабельность 

1 6.727273 0.623579 не рент. 

2 4.372727 0.554121 не рент. 

3 5.381818 0.768088 не рент. 



4 3.7 0.137848 рент. 

5 5.213637 0.440325 рент. 

6 6.390909 0.259315 рент. 

 


